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Document Introduction
This document is intended for persons who install and upgrade software for FX Supervisory
Controllers.
This document describes the detailed procedures for upgrading FX Workbench 6.x and earlier, the
steps for migrating to FX Supervisory Software 14.x., and the steps for upgrading from earlier 14.x
software to the latest 14.x version.

Product discontinuations
FX Supervisory Controllers and FX Server are all built upon a software framework called Niagara®.
Niagara integrates diverse systems and devices, regardless of manufacturer or communication
protocol, into a unified platform that you can manage in real time using a standard Web browser.
The Niagara Framework has evolved to the point where you must migrate any existing, upgradable,
AX
Niagara platforms and stations (that is, any FX software release prior to 14.0) to a later release –
AX
FX 14.10.0 is strongly recommended. The final date to order Niagara is June 1, 2021 and from July
1, 2021, no new licenses or option parts will be created or sold for any release prior to 14.0.
Important: You cannot upgrade older supervisory controllers, such as the FX70 and FX60s, to
any FX software release later than 14.4.
Table 1: Migration scenario
Scenario

Steps

If you are operating on a system that
runs on any FX software release prior to
14.0 and you need to replace or add an
FX80 after July 2021.

•

Prior to July 2023, you can purchase a license for
your supervisor and migrate the supervisor to the
latest software release.

•

You will also need to migrate the station of the
FX80 you are replacing to the latest software
release, and install the migrated station into the
FX80.

Concepts
Ordering codes for Europe, Middle East, and Africa
Multiple ordering code sets have been introduced, to allow the tailoring to regional needs. All
products on a given order must come from the same set. To determine the correct code for your
region, complete the following steps:
1. Use the following table to first determine the proper product code set to use:
Table 2: Product code set
Product Code Set

Notes

Base

The original FX product codes

Base+E

Use this new set of codes only for the region(s) specified in Table 3.

2.

Use the following table to determine the correct product code set for your region:
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Table 3: Regional ordering information
Region

Product Code Set

North America
Base

Latin America, South America
Asia
Middle East

Base+E

Africa
Europe

FX Supervisory Controllers
FX Supervisory Controllers describe a family of hardware products.
•

The FX80 and the F4-SNC are the only actively manufactured controllers and recommended to
use in every new installation. For futher information on the F4-SNC, refer to the F4-SNC Product
Bulletin (LIT-12013699).

•

The FX20, FX40, FX60 are all no longer available to order and should be replaced with an FX80.

•

The FX30, FX60E, and FX70 have been discontinued and while they are still available to order,
they are now at the end-of-life stage. It is strongly recommended that an FX80 is ordered
instead.

Table 4: FX Supervisory Controller upgrade scenarios
Scenario
Your system includes an FX20 and/or FX40.

These supervisory controllers must be replaced
with an FX80. Refer to the FX80 Supervisory
Controller Product Bulletin (LIT-12012250) for
ordering information.

It is strongly recommended to replace these
supervisory controllers with an FX80 and
Your system includes an FX30, FX60, FX60E, FX70 upgrade to the latest software release.
running FX software release 6.x.
See Detailed Procedures for Migrating to
FX Supervisory Software 14.x for further
information.
Your system includes an FX80 running FX
software release 6.x or an unsupported version
of software release 14.x

It is strongly recommended to upgrade to the
latest software release. See Upgrading the FX
Workbench Software for more information.

FX Server
The FX Server software product is available for various computer platforms and provides:
•

Network integration of one or more for Facility Explorer 14, FX Supervisory Controllers, or IPbased devices (without any FX Supervisory Controllers).

•

Network-wide automation and coordination for one or more FX Supervisory Controllers
through master scheduling, and centralized, long-term, high-capacity storage of alarms and
trends.

•

Centralized, network-wide, web-based, graphical user interface for one or more FX Supervisory
Controllers supporting both local and remote access.

6
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(Release 6.x) FX Supervisor Controller Family Software DVD
(LP-FXWB-COPY)
This product and the associated 6.x software has now been discontinued. Copies of FX Workbench
6.3 to 6.7 are available for migration purposes on hvacnavigator.com. 14.x Workbench licenses
come with a 6.x license which will also enable you to run Workbench 6.x for migration purposes.
See Migrating the 6.x Station to Facility Explorer 14.x for more information.

Upgrading
Upgrading is the process of installing new software onto your computer, onto an FX Supervisory
Controller, or both.

Migration
Migration is similar to upgrading, but signifies a larger change in software. Migration typically
requires more steps and conversions to move forward.

Upgrade Pricing Policy
A 1 year minimum maintenance is required with any new FX Server or FX80 purchase. Maintenance
can be purchased in 1, 3, or 5-year increments. With each maintenance plan, you have access to any
new software developed during that time. If you let the maintenance lapse, and want it later, you
must buy the maintenance you missed plus the new maintenance.

Software Revision Numbering
All FX Supervisory Controller, FX Server, and FX Tools Supervisor software products incorporate an
instance of Niagara software. See the following table to find which revision of the Niagara software
is used in each FX Supervisory software release.
Important: Software version 14.4 is the final 14.x release that supports the FX30E, FX60E, and
FX70. After 14.4, the 14.x releases only supports the FX80. For a full overview of the supported
versions of hardware and FX / Niagara software, see Historical software revision numbering.
Table 5: Software numbering
Niagara base examples

FX equivalent

4.9

FX appends a 1 to the base Niagara release so
the equivalent software release for FX is 14.9

N/A

FX appends a dot release to distinguish when
there are multiple FX releases against a given
Niagara release. As an example, 14.9.1

4.9U1

FX increments a Niagara update release to the
base example. As an example, 14.9.2

N/A

FX adds its own specific features against the
base Tridium update release. As an example,
14.9.3
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Table 6: Niagara version used
SR

14.0

Key Identifying Features or Changes
Major release that allows FX Workbench to run on the Niagara
4 platform.
The jump from 6.x to 14.x was intentional to align with the
Niagara software version moving forward.

Niagara
Software
Versions

4.0.22.16

14.1

Major release that adds support for FX80 Supervisory
Controllers

14.2

Major release that adds Analytics 2.0 to FX Workbench. There is
also support for the Alarm Portal, more robust FX Server data
4.2.36.38
management features, and support for FX80 legacy drivers.

14.3

Major release that introduced two new RIO modules. The
release also adds new HTML5 screens to FX Workbench and
improved mobile web device functionality.

14.4

Major release adding new HTML5 screens to FX Workbench,
improving mobile web device functionality. Minor change
to the User Service making the scheduled access for users
available through the User Details section. The JCI User
4.4.73.6
manager has been removed. Updating an existing Nav file is
through the Tools menu. This is the last release that supported
legacy supervisory controllers such as the FX30, FX60, and
FX70.

14.4U1

Minor release that provides eighteen functional fixes. These
included updated firmware to solve FX80 WIFI modem failure,
a fix to Niagara Daemon Engine Watchdog, and fixes to
lexicons, hyperlinking, scrolling, and adding notes.

4.1.27.20

4.3.58.18

4.4.92.2

There was also internationalization fixes to lexicons and
locales along with web fixes to PDF Export, Webchart, popups,
PxIncludes and HTML5 property sheets.
14.6

Major release that provides a number of updates and fixes.
These include Auto Export, a feature only available on Facility
Explorer®, cybersecurity fixes and a mobile refresh update.

14.7.0

Major release that provides new provisioning steps for
common processes, a new template type called 'Application
4.7.109.20.3
Templates', and a secondary JACE port that supports the DHCP
server.

14.7.2

Minor release that provides a number of new FX features.
These include extending 14.7 with automatic meta-data
tagging of applications, a HTML5-based Point-ExtensionManager, point groups and a point-group-manager driven by
data tags, and the launch of CCT 13.0, replacing PCT.
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4.6.96.28

4.7.109.20.3
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Table 6: Niagara version used
SR

Key Identifying Features or Changes

Niagara
Software
Versions

14.8.0

Major release that provided support for Niagara 4.8. This
release provides a new Niagara dashboard to quickly assess
the security posture of your network, 802.1-x support for
network access authentication, and the use of client certificate
authentication to enable kiosk mode and station-to-station
connectivity.

4.8.110.5

14.9.1

Minor release that provides a number of new features. These
include an enhancement to the Auto Tagging feature, the
inclusion of Jar file signatures,TEC3000 color compatibility, and
additional security fixes.

4.9.0.198

14.9.2

Minor release that provides a number of new features. These
include an enhancement to the graphics with tag-based
visualization, the inclusion of Single Sign-On (SSO), improved
Edge tools, and additional security fixes.

4.9.1.30.2

14.10.1

Major release that provides a number of new features. These
include a system database support for Tag-based PX, improved
4.10.0.154.3
graphics performance on the FX80 Supervisory Controller, a
new video surveillance viewer, and additional tags and tag
groups added to the jciTagDictionary.

Software License Agreement
All Johnson Controls software is licensed. During the installation process, you must accept or
decline the terms of the software licensing agreement.

Preventing Unauthorized Software Duplication or Usage
Johnson Controls, Inc. uses the following two methods to prevent unauthorized software
duplication and usage.
•

Acceptance of the terms of the software licensing agreement legally prohibits duplicating or
using Johnson Controls Facility Explorer software tools without authorization. This method
applies to all Johnson Controls Facility Explorer software.

•

A properly formatted and installed license file (FacExp.license) is required to enable the
operation of FX Workbench, FX Workbench Pro, FX Alarm Portal, and FX Server.
Note: At Release 14.0 and later, a new Johnson.license is required to enable the operation of
the N2 driver.

License Files
License files are required to enable operation of FX Supervisory Controllers, FX Server, and FX
Tools Supervisor Pro. License files are keyed to the host ID. A host ID is unique to each hardware
platform.
•

Host IDs that begin with Win- are targeted to computers.

•

Host IDs that begin with Qnx- are targeted to FX Supervisory Controller.
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A license file is a text file (FacExp.license) that you can read but not edit. License files contain a
digital signature, and any attempt to edit them renders the files invalid.
Included in each license file is a list of features allowed to operate inside the host device. These
features may include network drivers, database drivers, the maximum number of devices allowed,
the maximum number of points allowed, tool profiles, and other feature options.
Also included in each license file is the version of Niagara software allowed to operate inside the
host device. When upgrading software in a host (computer or FX Supervisory Controller), the
license version must be equal to or greater than the software version.
AX

Niagara is to be discontinued so ensure that you update your software to the latest version. Refer
to Discontinuation of Facility Explorer supervisory hardware models FX30, FX60, and FX70 and Facility
Explorer 6.x software (LIT-12001208) for further information.
Also, if you are emailed the licenses, the Niagara 4 .zip file also contains the Johnson.license for N2.

Part Numbers
The FX80 requires three parts: the base (which comes with SD card), the device license, and the
maintenance license. Refer to the FX80 Supervisory Controller Catalog Page (LIT-1901010) for further
details. Refer to the FX80 Supervisory Controller Control Panel Assembly Catalog Page (LIT-1901017) for
details on ordering a Control Panel with an FX80 Controller.
Table 7: Suggested replacement FX30, FX60, and FX70 ordering information
Discontinued FX Supervisor order code
LP-FX3011E-1

Suggested replacement FX Supervisor order
code

LP-FX3021E-1

FXSC8BASE-0 (Wi-Fi embedded - North America
only)

LP-FX6011E-1

FX-SC8BDWIFI-0 (Wi-Fi disabled)

LP-FX6021E-1
LP-FX7011N-1
LP-FX7021N-1

FX-SC8CL###-0 (Core device license)
FX-SC8DL##-0 (Additional device license)
FX-SC8D###M#-0 (Maintenance license)

LP-FX30BDEM-1

FX-SC8BASE-0

LP-FX60BDEM-2

FX-SC8CLDEMO-0

LP-FX6011E-1G

None

Refer to Discontinuation of Facility Explorer supervisory hardware models FX30, FX60, and FX70 and
Facility Explorer 6.x software (LIT-12001208) for further information on migrating 6.x licenses to a
corresponding or similar 14.x release.

Detailed Procedures for Upgrading FX Workbench
6.x and Earlier
Note: If you are using Facility Explorer 5.x or earlier and want to migrate to Facility Explorer
14, you must purchase the upgrade part to move to Facility Explorer 6.x before you move
to Facility Explorer 14.x. To migrate to Facility Explorer 14.x, see Detailed Procedures for
Migrating to FX Supervisory Software 14.x.
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This section describes how to back up your FX Supervisory Controller and prepare it gor upgrading.
It also provides detailed instructions on how to upgrade FX Workbench, re-license the FX
Supervisory Controller, and install new software into the FX Supervisory Controller.

Backing Up Your FX Supervisory Controller Station
1.
2.
3.
4.
5.
6.
7.

Expand the Nav tree for the station you want to back up.
In the Nav tree, expand Platform.
Double-click Station Copier.
Select the station that you want to copy from the Stations on panel.
Click Copy.
Enter a name for the Station name and click Next.
Select Copy every file in the station directory and its subdirectories and click Next.

Table 8: Transferring Station Copy Options
Feature

Description

Copy files from selected directories

Allows you to select individual files to copy
and transfer

Copy every file in the station directory and its
subdirectories

Copies all files for transfer (recommended
for backing up a remote station during this
upgrade procedure)

Copy only the config.bog station database file

Copies the station database only (for
example, drivers, devices, and points) and no
associated files

Click Next. The station is stopped.
Verify that the transfer information is correct and click Finish. The station files are transferred
to your computer. When the transfer is complete, the Save station and Transfer files
indicators turn green, and the last entry in the Transferring station window states Transfer
complete
10. Click Close. The remote station is now backed up to your computer.
8.
9.

Preparing Your FX Supervisory Controller for Upgrading
Upgrading FX Supervisory Controllers typically requires additional memory.
Note:
•

You must make sure your FX Supervisory Controller has an adequate amount of memory
before you attempt the upgrade. If you attempt to upgrade an FX Supervisory Controller
that does not have enough memory, the upgrade procedure fails and your FX Supervisory
Controller may become unrecoverable.

•

Do not attempt to upgrade an FX40 (with standard memory, 128 MB RAM, 31 MB flash) to
version 2.2 or higher. The FX40 does not have enough memory to support this upgrade.

•

Do not attempt to upgrade an FX20 to Release 5.0 if the /ffs0 partition is less than 5.0 MB
of file space. To see how much free file space is available, open the Platform\Platform
Administration view and note how much file space is free. If there is less than 5.0 MB
free, we do not recommend that you upgrade to FX20 (1024 KB = 1 MB. 5120 KB = 5 MB).
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Checking for Minimum Memory Requirements
1.
2.
3.

Start FX Workbench on your PC.
Connect to the FX Supervisory Controller by selecting File > Open Remote Station and
entering the IP address and platform and station login credentials.
In the Navigation sidebar, expand Administration, double-click Platform, and verify the file
system (/ffs0) has the minimum memory requirements identified in Table 9. If it does not, see
before continuing with this upgrade.

Table 9: Approximate Memory Requirements for Upgrading
Feature

Description

From 1.2 to 2.0

3072 KB (3.0 MB)

From 1.2 to 3.0

Not recommended

From 2.0 or 2.1 to 3.0

10,000 KB (10 MB)

From 2.2 to 3.0

5,000 KB (5 MB)

From 3.0 to 4.1

5,000 KB (5 MB)

From 4.1 to 5.0

5,000 KB (5 MB)

4.

If your FX Supervisory Controller does not contain the minimum memory requirements, then
delete unused files to increase the file space. Some files that are likely unused are the Graphic
Templates stored in the sysGraphicsFile, sysGraphicsFileHx, sysPxFile, and sysPxFileHx
folders.
Note: If you delete all the unused files and the minimum required free space is still not
available, the FX Supervisory Controller cannot be upgraded.

Upgrading the FX Workbench Software
About this task:
You use FX Workbench to upgrade the FX Supervisory Controller. Therefore, you must upgrade your
FX Workbench software before you can upgrade your FX Supervisory Controller.
Table 10: Email address for license request
Base

Base+E

software.manufacturing@jci.com

SW.Authorize@jci.com

1.

Email a request for an upgraded license to your FX Workbench. Use Table 10 to determine the
correct email address for your region. In your email, please provide your host ID (Win-####).
Note: If your FX Workbench software is not currently part of a software maintenance
agreement, you need to order a software upgrade. Include your purchase order number
on the same email.

2.
3.

Receive the upgraded FX Workbench software license, unzip it, and paste it into the licenses
folder ( FXWorkbench-14.x\security\licenses).
Obtain the most recent version of FX Workbench by downloading it from the Pro FX User
Connected Community on http://hvacnavigator.com.
Note: The license file you obtained in Step 2 should be automatically copied from your
previous installation directory and pasted into the licenses folder of your new installation
directory. If not, copy and paste it there.

4.
5.
12

Navigate to the downloaded license folder (Start > Programs > FX Workbench 14.x >
FX Workbench 14.x Pro) and then right-click on the Installer.exe file.
Click Run as adminstrator to install the software.
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Relicensing the FX Supervisory Controller
About this task:
If your FX Supervisory Controller is not currently part of a software maintenance agreement, you
must order a software upgrade license.
1.

Email a request for an upgraded license. Use Table 10 to determine the correct email address
for your region. Provide your host ID (Qnx-####) and purchase order number (if buying a
software upgrade license).
2. Receive the upgraded FX Supervisory Controller license and paste it into the licenses folder of
your FX Tools Supervisor Pro installation directory (C:\JCI\FXWorkbench-x.x\security
\licenses).
3. Start FX Workbench by clicking Start > Programs > FX Workbench 14.x > FX Workbench 14.x
Pro.
4. Connect to the FX Supervisory Controller by selecting File > Open Remote Station and
entering the IP address and platform and station login credentials.
5. Expose the Nav tree.
6. In the Nav tree, double-click Platform.
7. Double-click License Manager.
8. Click Import.
9. Click Import one or more licenses from files.
10. Click OK.
11. Select the location of the new FX Supervisory Controller license file you received in Step 2.
Note: Select the license with Qnx- in the Host ID number.
12. Click OK.
13. Click Yes on the Licensing Complete dialog box to reboot the system.
Note: The reboot process can take up to 5 minutes depending on network and
computer performance. There is no indicator for the progress of the reboot. If an
attempt to reconnect to the FX Supervisory Controller fails, wait for the system to
complete the reboot and try again.
14. Reconnect to the FX Supervisory Controller after the reboot process has completed.

Installing New Software into the FX Supervisory Controller
1.
2.
3.
4.
5.
6.
7.

8.
9.

Start the latest release of FX Workbench by clicking Start > Programs > FX Workbench 14.x >
FX Workbench 14.x Pro.
Connect to the FX Supervisory Controller by selecting File > Open Remote Station and
entering IP address and platform and station login credentials.
Expand Platform.
Double-click Platform Administration and then click Commissioning.
Leave the default selections and click Next.
Verify that the license revision installed on the FX Supervisory Controller allows you to install
the latest software.
Click Install one or more licenses from files if the FX Supervisor requires an upgraded
license. Click Don't change any licenses if the installed license supports the FX Supervisory
Software revision being added.
Click Next.
Click UI+RUNTIME and click Next.
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10. In the Station list, select Don't transfer a station and click Next.
Figure 1: Commissioning Wizard - Software Installation

Figure 2: Commissioning Wizard - Software Installation

11. Click Upgrade All Out of Date. The system selects the check boxes next to the out-of-date
software. Use the scroll bar to locate and add additional .jar files that were added with the
new release but may not have been on the FX Supervisory Controller that is being upgraded.
In the Avail. Version column, look for .jar files from Johnson Controls. Select the
check box to include a .jar file in the upgrade process. For example, if you select the
jciAutoImport .jar file, then the file is included with the upgrade.
You do not need to add .jar files like jciLX, jciLXDevices, or jciLXMain unless you
have a LonWorks® network.
12. Click Next. The Distribution File Installer lists the software that needs to be installed.
13. Click Next.
14
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14. Leave the default selections and click Next.
15. Keep the current Platform name and password and click Next.
16. Click Finish. The station stops running. All .jar files are now updated.

Upgrading FX Server
1.

2.
3.
4.

If your FX Server is not currently part of a software maintenance agreement, you must
order a software upgrade license. Email a request for an upgraded license. Use Table 10 to
determine the correct email address for your region. Provide your host ID (Win-####) and
purchase order number (if buying a software upgrade license).
When you receive the upgraded FX Server license, paste it into the licenses folder of your FX
Server installation directory (C:\JCI\FXServer-x.x\licenses).
To obtain the most recent version of FX Server, download it from the Pro FX User Connected
Community on http://hvacnavigator.com.
Install the new FX Server software.
Note: The license file you obtained in Step 1 should be automatically copied from your
previous installation directory and pasted into the licenses folder of your new installation
directory. If it is not, copy and paste it there.

5.
6.

Copy your station files from the old FX Server installation directory (C:\JCI\FXServer-x.x
\stations\station name) to the new FX Server installation directory.
Run the software by clicking Start > Programs > FX Server.

Detailed Procedures for Migrating to FX
Supervisory Software 14.x
Migration is similar to upgrading, but signifies a larger change in software. Migration typically
requires more steps and conversions to move forward.
In the Appendix of this document, a high-level migration checklist has been provided to assist with
your decision on migration. See the Migration Checklist.
Prerequisites for Migration
If you are not at FX Supervisory Software 6.x, you must upgrade to FX Supervisory Software 6.x
before you migrate to FX Supervisory Software 14.x.
Before migrating an FX Supervisory controller, you need to have the following:
•

a station running FX Supervisory Software 6.x. To upgrade FX Supervisory Software 6.x, see
Detailed Procedures for Upgrading FX Workbench 6.x and Earlier.

•

a licensed version of FX Supervisory Software 14.x on your computer

•

new FX Supervisory Software 14.x licenses for the controller that you are migrating

FX Supervisory Software 14 Migration Considerations
Many factors should weigh into the decision on whether or not to migrate an FX Supervisory
Controller and FX Server. This section provides guidelines for migration of your application.
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Considering Platform Compatibility
Determine if the desired platform is compatible with FX Release 14.9 and later. Use the following
table as a reference.
The information in the following table does not guarantee that you can migrate the station on that
platform; instead, the table explains which platforms are not able to migrate.
Table 11: Platform Compatibility
Compatible with FX Release 14.9
and later

Platform
FX Supervisory
Controllers

•

FX80

Not Compatible with FX
Release 14.9 and later
FX20, FX30, FX40, FX60, and FX70
Windows® Vista®

FX Server

Windows 8.1

Windows XP

Windows 10.0

Windows Server 2008

Windows Server 2012

Windows 7
Linux®

Options for dealing with incompatible platforms include:
•

Keep incompatible platform at FX Workbench Release 6.x. These platforms can interact with
platforms at FX Release 14.x with some limitations. The FX Server must be at FX 14.x, if any
other supervisory controller on the network is at FX 14.x. For example, to install or upgrade any
supervisory controller to FX 14.x, you must update the FX Server to 14.x. The FX Server must be
at the highest release, or greater, of any FX80 on the network.

•

Replace the platform with a compatible platform.

Table 12: FX Supervisory Controller Network Compatibility
From

To

Supported

Notes

FX Supervisory
Controller 14
(Station)

FX Supervisory Controller
6.x (Station)

Yes

Limited

FX Supervisory
Controller 4.x to 6.x
(Station)

FX Supervisory Controller
14 (Station)

Yes

With exceptions

FX Supervisory
Controller 14
(Station)

FX Server 6.x

No

Not blocked

Yes

Connection is available for
migration process to FX
Supervisory Software Release
14

FX Workbench 14

16

FX Supervisory Controller
6.x (Platform)
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Table 12: FX Supervisory Controller Network Compatibility
From

To

Supported

Notes

FX Workbench 14

FX Supervisory Controller
6.x (Station)

No

Blocked

FX Workbench 6.x

FX Supervisory Controller
14 (Station)

No

Blocked

FX Workbench 6.x

FX Supervisory Controller
14 (Platform)

No

Blocked

For more detailed information on compatibility, in FX Workbench 14 Pro from the Help menu, select
Help Contents. Click the Search tab and type compatibility.

Considering Driver, Feature, and Application Compatibility
You must also consider driver, feature, and application compatibility. Facility Explorer Release 14
is a significant code base change. For modules that worked at Facility Explorer Release 6.x and
earlier to work at Facility Explorer 14 and later, they must be refactored. All modules developed by
Johnson Controls have been refactored for use in Facility Explorer Release 14 with the exception of
the Wireless TEC module.
Table 13: Johnson Controls Modules
Johnson Controls Module

Refactored FX Release 14.x

jciAutoImport.jar

Yes

jciBacnetParser.jar

Yes

jciBACnetTEC.jar

Yes

jciCoreParser.jar

Yes

jciDictionary.jar

Yes

jciFxDriver.jar

Yes

jciFxDriverAppliance.jar

Yes

jciFxDriverHx.jar

Yes

jciMeters.jar

Yes

jcin2.jar

Yes

jciN2Parser.jar

Yes

jciN2TEC.jar

Yes

jciSpaces.jar

Yes

jciSupport.jar

Yes

jciTools.jar

Yes

kitPxHvacSmall.jar

Yes

wirelessStat.jar

No

Note: The Wireless TEC module is loaded by factory default on all of the FX Supervisory
Controllers. The FX14UpgradeAssessmentTool does alert you that this module has not been
refactored for use for Facility Explorer Release 14. If the Wireless TEC is not being used, you
may choose to ignore this alert. We recommend, however, that you remove this module if it
is not in use. If the TEC module is being used, then the FX Supervisory Controller should not
be migrated to Facility Explorer Release 14. This module is for the older generation Wireless
TEC2000 models, and is not compatible with the FX80.
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Note: The TEC3100 wireless needs a WRG coordinator for usage.
For Niagara driver and application support, refer to the Niagara 4 Driver and Application Support
Section within the Niagara Help system to determine which drivers have been refactored for
Niagara 4 and FX Supervisory Software Release 14.
If the platform, drivers, features, and applications have been determined to be compatible and/or
supported for use with FX Supervisory Software Release 14, do the following:
1.

If the platform is at a release less than FX Supervisory Software Release 6.x, you must purchase
and upgrade that platform to FX Supervisory Software Release 14.x and ensure it is running
properly before moving further.

2.

On supported FX Supervisory Controller platforms, run the FX 14 Upgrade Assessment Tool
to determine if the required resources are available. See FX Supervisory Software 14 Resource
Requirements.

3.

If the resource requirements are met, purchase the software maintenance parts for the
appropriate platform. Software maintenance may be purchased in 1, 3, or 5-year increments.
For more information on software maintenance parts, refer to the FX Supervisory Controller
Product Bulletin (LIT-12012250).

4.

Follow the instructions on migrating your platform and station.

Considering License Compatibility
Licensing has been changed for FX Supervisory Software 14 and later. Licensing is moving from a
driver and integration model (FX Supervisory Software 6.x and earlier) to a field controller capacity
model (FX Supervisory Software 14.x and later).
FX Workbench, FX Servers, and FX Supervisory Controllers require the appropriate license to match
the Facility Explorer Release that it is running. For example, an FX Supervisory Controller running at
Release 6.1 requires the Niagara AX license.
Figure 3: FacExp.license in FX Workbench 6.1

In Figure 3, notice the FacExp.license (Niagara AX) in FX Workbench 6.1. The version is 3.8 and that
the jciN2 license is part of the FacExp.license file.
An FX Supervisory Controller running at Release 14.x requires not only a Niagara 4 license, but also
a Johnson Controls license (this is for the N2 protocol which was separated from the overall Niagara
AX license).

18

FX Supervisory Controller Upgrade and Migration Instructions Technical Bulletin

Figure 4: License in FX Workbench 14.x

In Figure 4, notice the FacExp.license (Niagara 4) in FX Workbench 14.x. Its version is 4.0 and no
jciN2 license is included.

Figure 5: Johnson.license

Figure 5 displays the Johnson.license (Niagara 4) in FX Workbench 14.x. This license is required
when using the N2 protocol.
In general, a licensing model stays with a product throughout its lifetime. Parts purchased with an
LP- prefix follows the FX Supervisory Software 6.x and earlier license models. Parts purchased with
an FX- prefix follows the FX Supervisory Software 14.x and later 4.x license models.
The only exception to this rule is that to migrate a platform from FX Supervisory Software 6.x to FX
Supervisory Software 14.x, you must purchase and apply an FX- software maintenance part to an
LP- platform.
Note: Products with LP- prefix do not ship with Facility Explorer Release 14.x and later. These
products must be migrated in the field to use FX Supervisory Software 14.

Example of an FX Supervisory Controller Migration
Using the following flowchart as an example of when to migrate to FX Workbench 14.x.

FX Supervisory Controller Upgrade and Migration Instructions Technical Bulletin

19

Figure 6: Migrating an FX60 Supervisory Controller

FX Supervisory Software 14 Resource Requirements
About this task:
Facility Explorer 14 requires more disk space, Java® heap, and RAM to run than a similar Facility
Explorer 6.x station. Therefore, a controller with Facility Explorer 6.x running near capacity may not
fit the same-sized station when migrated to FX Supervisory Software 14. The reasons are as follows:
•

Disk space (flash)–FX Supervisory Software 14 requires between 14 to 16 MB more space
than an equivalent FX Supervisory Software 6.x installation. Additional space is required by
the new Java 8 Virtual Machine (VM) and new HTML5 UX features that enable a rich browser
experience.

•

Heap space–For an equivalent station, more Java heap is required due to new features and
functionality. The baseline heap increase is about 10 MB. Additionally, more system memory is
required.
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•

History RAM disk size (FX60 and FX60E only)–The maximum history RAM disk size on an
FX60 has been reduced from 64 MB to 32 MB to free additional system memory. The default
RAM disk size is 32 MB, so this should not affect most units. If the RAM disk on an FX60 with FX
Supervisory Software 6.x has been upgraded, then this increase in the RAM disk size comes at
the expense of heap space (for example, if you upgrade your memory, the additional 32 MB is
allotted for heap space and is not usable as RAM post-migration).

Note: Maximum history count has not changed.
Run the FX14UpgradeAssessmentTool on the Release 6.x Supervisory Controller to determine if it
meets the minimum requirements to be migrated to FX 14. The FX14UpgradeAssessmentTool is a
program that is included with the FX Workbench 14 installation. The program checks your controller
for memory and heap resources, disk space, .jar files, and for password encryption.
Note: For the migration, the Facility Explorer Upgrade Assessment Tool automatically
modifies the Backup Service to include the history and alarm data in the backup process
(which comes later in the process). However, because of possible size limitations, the four
graphics folders (sysGraphics file, sysGraphicsFileHx, sysPxFile, and sysPxFileHx) are removed
from the backup process. Although space is gained by the removal of these graphic files,
you no longer have access to these files after the migration. These files may be added postmigration as space allows.
Important: After the FX14UpgradeAssessmentTool has completed, you must delete it from
the station; otherwise, it may cause the migration tool to fail.
Note: Before you perform this procedure, you must first install FX Workbench 14.
Default Values for the Backup Service Exclude Files and Directories
The following default values for the Backup exclude files and directories of the Backup Service.
If needed, you can change these settings after a station migration, so that the backup of the
station has the original settings.
Table 14: Default Values for the Backup Service Exclude Files and Directories
Field

Description

Exclude Files

*.hdb;*.adb;*.lock;*backup*;console.*;config.bog.b*;conf
ig_backup*

Exclude Directories
Offline Exclude Files

file:^^history
file:^^alarm
*.lock;*backup*;console.*;config.bog.b*;config_backup*

Checking for FX Supervisory Software 14 Resource Requirements
About this task:
To check for FX Supervisory Software 14 Resource Requirements:
1.
2.

Start FX Workbench 6.x by clicking Start > Programs > FX Workbench 6.x > FX Workbench Pro
6.x.
In the Nav tree, expand:
My Host > My File System > C > JCI > FXWorkbench-14.x > jciStandards > to view the
FX14UpgradeAssessmentToolV1_9.bog
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Figure 7: Copy Bog File

3.
4.

Right-click the FX14UpgradeAssessmentTool program object, and select Copy.
In the Nav tree, connect to and expand the station you want to migrate.
Important: You must run the assessment tool on the FX Supervisory controller station.
The tool cannot check the appropriate resources when the station is moved to run from
a computer.

5.
6.

Under Config > Services, right-click ProgramService and select Paste.
If you want to change the FX14UpgradeAssessmentTool program object name,
enter the new name and click OK. Otherwise, leave the name as is and click OK. The
FX14UpgradeAssessmentTool now appears under ProgramService.

Figure 8: Change Tool Name
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Figure 9: Paste File

7.

Expand ProgramService and right-click FX14UpgradeAssessmentTool and select Actions >
Check Upgrade Status.
The tool generates a dialog box that displays requirement information and indicates if
the device meets the minimum requirements for migration to FX Workbench 14.
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Figure 10: Facility Explorer Upgrade Assessment

The FX14UpgradeAssessmentTool also indicates if it finds third-party modules
(modules that are not Tridium modules). All Johnson Controls modules work with FX
Workbench 14.x with the exception of the wirelessStat.jar.
Important: The NEEDS Update! WirelessStat message always appears. The
WirelessStat.jar file is included with every FX Workbench installation, but does not
work with FX Workbench 14.x. If you are using the wirelessStat driver for wireless TEC
controllers, you are not able to migrate to FX Workbench 14.x.
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Important: The Client Password Test is a test to see whether user passwords can be
decrypted by the tool. If the test fails, you must go back to the FX Workbench 6.x version
of the station and re-enter the credentials, backup, and start again.
8.
9.

Click OK.
To view additional information, double-click the FX 14 Assessment Tool.

Figure 11: Upgrade Compatibility Tool Property Sheet

10. In the Nav tree, right-click FX14UpgradeAssessmentTool and click Delete.
Note: To view a .txt file of the upgrade status, double-click Files from the Nav Tree for
the station. Double-click CompatibilityToolLog.txt. A .txt file appears displaying a text
version of the status generated by the compatibility tool.
Important: After using the FX14UpgradeAssessmentTool, you must delete it from the
station; otherwise, the tool may cause the migration tool to fail.

Checking for Multiple Admin Roles
About this task:
To migrate a station, you must not have more than one user with the name Admin. If you have
more than one user with the name Admin, you must delete the extra users. If more than one user
exists with the same Admin name, the migration fails.
1.
2.
3.

In the Nav tree, expand Station > Config > Services.
Double-click User Service. The User Manager appears.
In the view selection on the top-right side of the screen, select AX Slot Sheet.
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4.

5.

Review the names in the Name column. In the example above, notice that slot number 9
contains admin and slot number 14 contains ADMIN. Only one admin name is allowed (even
if capitalization is different). The user roles have the baja:User type.
If you have more than one user with the name Admin, right-click the duplicate name (with
the baja:User type), and select Delete.

Backing Up Your FX Workbench 6.x Station
About this task:
For the migration to FX Supervisory Software 14, back up the station using FX Workbench 6.x. You
cannot backup a 6.x FX Supervisory Controller from FX Workbench 14.
Note: Make sure to move the station from the FX Supervisory Controller to the Local Host via
the Station Copier after you back up the station. Doing this guarantees that there is space on
the FX Supervisory Controller when you install FX Workbench 14.
1.
2.

In FX Workbench 6.x, connect to the station you want to back up.
Right-click the station you want and select Backup Station. A screen appears prompting you
to save the backup .dist file to a location.

Figure 12: Station Backup

3.
4.

If necessary, enter a different name of the backup in the File name field.
Click Save. You can view the backup in the BackService, which is located in Station >
Administration > BackupService.
Note: You can also back up your station by going to Station > Services> BackupService,
selecting the desired .dist file, and clicking Backup.
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Running Platform Daemon 14.x
When opening the Platform Daemon 14.x, you are indicating the version of FX Workbench you want
to run.
Note:
•

Certain antivirus programs may attempt to block you from running the Platform Daemon
software.

•

Before running the platform daemon, be sure to close out any instances of FX Workbench
software.

Click Start > FX Workbench 14.x > Install Platform Daemon 14.x. You can now start FX Workbench
14.

Migrating the 6.x Station to Facility Explorer 14.x
About this task:
During the station migration, we recommend that you have a serial shell open to help you monitor
the migration. Having the serial shell open helps you monitor the items being loaded on the FX
Supervisory Controller, track errors, and view when the migration is finished. For more information
about the serial shell, see the About JACE Serial Shell Mode section of the Niagara Help.
•

By default, files in the SysPxFile, SysPxFileHx, SysGraphicsFile, or the SysGraphicsFile folders
are not migrated to the converted station.

•

If you are migrating a station that uses older graphics with a tab pane, you need to clean the
graphics up to remove the tabs.

1.
2.
3.

4.

Start FX Workbench 14.
On the Tools menu, click Migrate Station.
In the Backup DIST Name (Ver 3.8) field, click the folder button and select the .dist file from
the FX Workbench 6.x backup directory. For example, c:\JCI/FXWorkbench-6.2/backups/
backup_SunriseClinic_151121_0914.dist. After selecting the .dist file, click Open.
Do one of the following:
- If you are migrating an FX Supervisory Controller station, click Migrate JACE Station.
- If you are migrating in FX Server, click Migrate FX Server Station.

5.

Click Migrate Station. The migration tool begins the migration process. The migration
background screen appears. Use this screen to monitor the progress of the migration. This
process can take several minutes.
As the migration is running, the system creates a log file whose name is a the
combination of backup .dist file name (backup_SunriseClinicA_Migrate.dist)
plus _miglog_ plus the date/time code 151007_1539 plus .html.
For example:
backup_SunriseClinicA_Migrate.dist_miglog_151007_1539.html.
Locate the log file in the Nav tree under My File System > User Home > stations.
Note: Before the migration process finishes, a lock file is created that uses the log file
name plus .lck file name extension. Once the migration finishes, this .lck file is delete.
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6.

7.

The Migration screen displays that the migration is completed. When prompted by the
migration background screen, press any key to continue. Windows Explorer appears and is
opened to the directory where the migration .log file was placed.
Click Close. The station has now been migrated and is ready to be loaded on the FX
Supervisory Controller.

Installing the Distribution File
About this task:
1.

On the File menu, select Open > Open Platform. The Connect screen appears.

Figure 13: Connect

2.

In the Type field, select the session type.
Important: The Type field defaults to Platform TLS Connection, which may not be
enabled on the controller. Select Platform Connection if TLS is not enabled.

3.
4.
5.

Enter the IP address of the device to migrate and click OK.
Log into the Platform for the device you want to migrate. These credentials are the same
credentials used to log into the platform of the FX Supervisory Controller at Release 6.1.
In the Nav tree, double-click Platform > Platform Administrator. The Platform Administrator
screen appears. Confirm that the Baja Version Niagara 3.8.x.
Note:
- If the Baja version is less than 3.8.x, then you must first upgrade to FX Workbench
6.x. See Detailed Procedures for Upgrading FX Workbench 6.x and Earlier.
- A warning message may appear on the screen indicating the default platform
credentials. The migration process requires you to change the default platform
credentials to a different user name and strong password.

6.
7.
8.
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In the Nav Tree, expand Platform and double-click Distribution File Installer. The
Distribution File Installer screen appears.
On the bottom of the screen, click Conversion. Conversion files that are not appropriate for
use on the current FX Supervisory Controller are disabled.
Select the bold (non-disabled) .dist file and click Install. A message appears indicating that
running applications need to be stopped before the installation can proceed.
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Figure 14: Stopping Applications

Click Finish. FX Workbench 14 installs the base Niagara 4 image on the controller. The status
of the installation appears on the Installing Distribution screen. The installation may take
several minutes.
10. When the installation is complete, click Close. The controller reboots. The reboot may take
several minutes.
11. Log back into the platform and open the Platform Administrator. Confirm that the device
Daemon Version now says 4.0.xx.xx and the Baja version is blank. The installation of the
conversion distribution file may revert the platform credentials back to the default values.
9.

Commissioning the Station
About this task:
After migrating the station to FX Supervisory Software 14, you need to commission the station.
1.
2.

In the Nav tree, expand Platform.
Double-click Platform Administrator.

3.

Click Commissioning.
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Figure 15: Commissioning Wizard

4.

Select the check boxes based on the following table. Make sure the Configure additional
platform daemon users is checked.

Table 15: Commissioning
Field

Description

Request or install software licenses

Preselected and disabled for any new FX
Supervisory controller

Set enabled runtime profiles

Preselected and disabled for any new FX
Supervisory controller

Install a station from the local computer

Ensure that this field is selected as you will be
installing the new migrated station from a local
computer.

Install lexicons to support additional languages

Option to install file-based lexicon sets
(alternative to lexicon modules). Typically you
leave this field unselected. Lexicon modules are
recommended in FX 14.
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Table 15: Commissioning
Field

Description

Install/upgrade modules

Always preselected when the wizard is run.
Selects the software modules and optionally any
lexicon modules.

Install/upgrade core software from distribution
files

Preselected and enabled for any new FX
Supervisory controller
Preselected in most cases. For new controllers
(for example) where the controller time may
greatly differ from actual time.

Sync with my local system date and time

Note: Ensure that this field is selected to
update the date and time from the defaults
placed in the controller with the conversion
AXtoN4 distribution file.

Configure TCP/IP network settings

Recommended

Configure system passphrase

Preselected and enabled for any new FX
Supervisory controller

Remove platform default user account

Preselected and enabled for any new FX
Supervisory controller. You cannot commission
a unit with the factory-default platform admin
user.

Configure additional platform daemon users

Recommended option if you require additional
platform admin user accounts with unique user
names and passwords (all additional accounts
have full and equal privileges).

5.

Click Next. The Station Installation screen appears.

Installing or Updating Licenses
About this task:
1.
2.
3.
4.

Select Install one or more licenses from files if you have the FX Workbench 14 license file.
Click Add and select the required licenses. The licenses appear on the right side of the screen.
Click OK.
Click Next.

Setting the Enabled Runtime Profiles
About this task:
Enabled runtime profiles specify what types of FX Supervisory Software 14 software module .jar files
to install.
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Figure 16: Enabled Runtime Profiles

1.

Use the following table as a reference. Make sure to select both the UX and WB check boxes.

Table 16: Enable Runtime Profiles
Field

Description

RUNTIME: Module JARS having core runtime
Java classes only, no user interface.

Read-only. Always selected.

UX: Modules JARs having lightweight
HTML5+Javascript+CSS user interface only.

Select to support web client browser access,
using HTML5, Javascript®, and CSS technologies.
The client does not need to run Java and
download WbApplet from the controller. When
you select this field, the WB field is also selected.
Note: Certain views at FX Release 14 have
not been converted to HTML5. These views
include the Device Manager, Wire Sheet,
and Px Editor views. They are scheduled to
be converted at a future release.

WB: Modules JARs having Workbench or
Workbench Applet user interface classes.

Auto-selected when you select UX. Select WB
if the supervisory controller must also support
browser Web Workbench access from Javaenabled clients, using the WbApplet.

SE: Modules JARs having Java classes that use
the full Java 8 Standard Edition (SE) platform
API.

Not available for QNX-based FX Supervisory
Controllers.

DOC: Modules JARs having no module classes.

Selectable, but not recommended for file space
reasons on an FX Supervisory Controller.

2.
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Click Next. The Station Installation screen appears.
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Specifying a Station to Install
About this task:
To commission the station, you must first specify the station to install.
Figure 17: Station Installation

1.
2.
3.
4.

In the Station box, select the name of the station database on your computer.
If desired, enter a new station name. Otherwise, do not change it.
Enter the system passphrase.
If desired, select one or both of the following check boxes (we recommend that you select
both check boxes):
- START AFTER INSTALL: Start the station immediately after it is copied.
- When you select this check box, the station is restarted at the end of
commissioning, even if you do not reboot the FX Supervisory Controller.
- AUTO-START: Start the station every time the platform daemon starts.
- When you select this check box, the station starts every time the FX Supervisory
Controller is rebooted.

5.
6.

Click Next. A dialog box appears asking which station files to copy.
Select one of the following:
- Copy files from selected directories (recommended)
- Allows you to specify which subfolders under that local station that are copied. This
action produces a tree selection after you click Next.
- Copy only the config.bog station database file
Copies only the station configuration (components), and not any supporting folders
and files (for example, PX files and HTML files).
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7.

Click Next. A screen appears asking you to select subfolders.

8.

Select the subfolder under the local station to copy. Expand the folders as needed. By default,
the directories are selected to be copied to the station. Directories that are not selected are
no longer required. Typically, you leave all directories selected.
9. Click Next. A dialog box appears asking you to select the software to install.
10. Select the software to install.
11. Click Next.

Installing Core Distribution Files
About this task:
During commissioning, the dependencies of the FX Supervisory Controller platform are compared
against the distribution (.dist) files available in your FX Workbench computer's software
database. The wizard determines what .dist files need to be selected for installation. The
software you need to install is displayed on the screen.
Click Next to select the distribution files. A TCP/IP configuration screen appears.

Configuring TCP/IP Settings
About this task:
To commission the station, you may need to update the station's TCP/IP settings.
1.
2.

Review the settings on the IPv4 Settings tab, which include the temporary factory-shipped IP
address.
Assign the controller a unique IPv4 address for the network you are installing it on. No other
device on this network should use this same IP address. Include the appropriate subnet mask
used by the network.
Alternatively, if the network supports DHCP, you can enable it by selecting the DHCPv4
Enabled check box. In this case, the IP Address and Subnet Mask fields become readonly.
Note: In general (for stability), we recommend static IP addressing over DHCP. Do not
enable DHCP unless you are certain that the network has DHCP servers.
Otherwise, the FX Supervisory Controller may become unreachable over the network.

3.

If needed, adjust other TCP/IP settings, which include:
- Hostname–Use the default localhost name or enter another name you want to use for
this host.
- Hosts File–Click the arrows to expand the edit field. The format is a standard TCP/IP
hosts file, where each line associates a particular IP address with a known host name.
Use a separate line for each entry. Place the IP address in the first column, followed by
the corresponding host name. The IP address and the host name are separated by at
least one space.
- DNS Domain Name–Enter the name of network domain, or if not applicable, leave the
field blank.
- IPv4 Gateway–Enter the IP address for the device (such as a switch or a router) that
forwards packets to other networks or subnets.
- DNSv4 Servers–Click the plus sign for a field to enter the IPv4 address of one or more
DNS servers.

4.
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Click Next.
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Updating the System Passphrase
About this task:
All Niagara 4 platforms have a system passphrase (password), which encrypts sensitive
information. This information includes client passwords stored in .bog files and station databases
(config.bog files) or station backup distribution (.dist) files. The passphrase increases
security for the files that contain critical information. In various FX Workbench 14 operations,
you are prompted to enter the passphrase, such as when copying stations or restoring station
backups in remote platforms. The following areas in the framework are affected by passphrase
implementation:
•

Provisioning

•

File Transfer Client

•

Station Copier

•

Backup

•

Commissioning

•

Export Tags

The sensitive information in files is protected with encryption, either by encrypting the information
within the files or by encrypting the whole file. How the encryption is applied depends on the
portability of the file. Files located under the daemon User Home (files that belong to the system)
are encrypted using a strong, randomly generated key that exists only on that system. Files located
under an FX Workbench 14 User Home (portable files that can be sent to many systems) are
encrypted using a key derived from the user-defined system passphrase entered during software
installation or when the system passphrase changes.
Due to the different types of encryption used for the system or portable location, when
transferring files between the daemon User Home and another FX Workbench User Home, you
must use the FX Workbench platform tools (Station Copier, File Transfer, or Backup). Using the
platform tools converts files to use the correct encryption key for the target location.
Important: Do not use Windows Explorer to copy files between the daemon User Home and
other User Homes because without the proper encryption, the files may not be readable.
For System-to-Portable Transfers
You can get portable copies of files located under the daemon User Home by any of these
methods:
•

Make a backup from the Platform Administration view

•

Make a backup from a running station

•

Use either Station Copier or File Transfer Client from the Platform Administrator view
The resulting local, portable copies and backup files are protected with a passphrase.
For Portable-to-System Transfers
When you use the Distribution File Installer to restore a backup .dist file, or if you use the
Station Copier to transfer a station from your FX Workbench directory to a controller, the file's
passphrase is validated and used to translate the data back into the proper system encryption
format for use under the daemon User Home.
Important: Remember the system passphrase and keep it safe. If you lose the system
passphrase, you lose access to encrypted data and you will need to revert to the default
system setup using the Serial Shell.
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1.

In the Current Passphrase field, enter the default platform password. Contact your local
Johnson Controls representative for the default password.
Note: If the default platform password has changed in the field, use the changed
password. If you have forgotten the default platform password, you can use the Serial
Shell method to reset to the default password.

2.

3.
4.

In the New Passphrase field, enter a new passphrase. The passphrase must be at least
10 characters long with one uppercase character, one lowercase character, and one digit
(numeral).
In the Confirm New Passphrase field, enter the new passphrase again.
Click Next.

Specifying a Platform User to Replace the Factory-default Platform User
About this task:
To commission a station, you need to create a new platform account.
1.

In the User Name field, enter a user name for platform login.
Note: You are not allowed to use jci as a user name.

2.
3.
4.

In the Password fields, type in a strong password (it must match in both password fields).
The password must use a minimum of eight characters, using at least one digit (numeral).
If you want, enter an alphanumeric descriptor for this platform admin user in the Comment
field. The comment is seen in the Users table if there are more than one platform user.
Click Next.
Note: The new platform user account is retained in the controller. For example, if you
migrate to FX Workbench 14 and then take the station back to FX Workbench 6.x, then
forward again to FX Workbench 14, you need to use the new platform credential defined
in this procedure.

5.

Do the following:
- To add new users, click New User and enter the user information.
- To delete users, select the user and click Delete User.
- To change a password, click the user and click Change Password. Enter the new
password.

Reviewing the Changes
About this task:
Before you finish commissioning, review the changes and make sure the commissioning selections
have been reflected. Click Back to correct any configuration errors when commissioning the
controller.
1.
2.

Click Finish. The Completing Commissioning screen appears. This process takes several
minutes.
After commissioning is complete, click Close. The Facility Explorer 14 station is now copied to
the controller. The controller is rebooted and may take several minutes to complete.

Changing the Default Web Profile to Use the HTML5HxProfile
About this task:

36

FX Supervisory Controller Upgrade and Migration Instructions Technical Bulletin

Beginning at FX Workbench 14, you can take advantage of a rich web experience without the need
to install and manage a Java based plug-in. Use the following procedure to change the default web
profile to the HTML5HxProfile.
Note:

1.
2.
3.
4.

•

The migrated station cannot render the Extensions tab of a graphic in HTML5 view.

•

Certain views at FX Release 14 have not been converted to HTML5. These views include
the Device Manager, Wire Sheet, and Px Editor views. They are scheduled to be converted
at a future release.

•

To add a new user which uses the HTML5HxProfile, you must first make a secure
connection to the station.

In the station, go to Config > Services > User Services.
Double-click the user. The user property sheet appears.
In the Default Web Profile section, select HMTL5HxProfile in the Type field.
In the Default Web Profile section, select the default FX Workbench display options based on
the following table.

Table 17: Default Web Profile
Field

Description

HX Theme

Select Zebra for a black and white color theme.
Select Lucid for a blue and gray color theme.

Enable HX Workbench Views

Select Yes to enable the HX Workbench View.
Select No to disable the HX Workbench View.

Enable Nav Tree Side Bar

Select Yes to enable the Nav Tree Side Bar.
Select No to disable the Nav Tree Side Bar.

Enable Palette Side Bar

Select Yes to enable the Palette Side Bar. Select
No to disable the Palette Side Bar.

Enable Nav File Tree

Select Yes to enable the Nav Tree. Select No to
disable the Nav Tree.

Enable Config Tree

Select Yes to enable the Config Tree. Select No
to disable the Config Tree.

Enable Files Tree

Select Yes to enable the Files Tree. Select No to
disable the Files Tree.

Enables Histories Tree

Select Yes to enable the Histories Tree. Select
No to disable the Histories Tree.

Enable Hierarchies Tree

Select Yes to enable the Hierarchies Tree. Select
No to disable the Hierarchies Tree.

5.
6.

In the Type Spec field, select hx and then HTML5HxProfile.
Click OK.
Note: To update an existing Nav file when you upgrade to FX 14.4, click Tools and select
Update Home Page Graphic.

Viewing and Updating Metaspace
About this task:
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Use the following procedures if you receive an error in the Application Director indicating that you
are out of metaspace.

Viewing Metaspace
1.
2.
3.

In the Nav Tree, right-click on the station and select Spy. A Remote Station menu appears on
the screen.
Click util. A util menu appears on the screen.
Click JMX Info. A JMX Info screen appears.

Updating Metaspace
About this task:
Use the following procedures if you receive an error in the Application Director indicating that you
are out of metaspace. The station is automatically restarted after the metaspace memory allocation
has been updated.
1.
2.

In your station, log into the Platform.
In the Nav tree, double-click Platform Administration. The Platform Administration screen
appears.

Figure 18: Platform Administration

3.
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Click Configure NRE Memory. The Configure NRE Memory Pools screen appears.
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Figure 19: Metaspace Size - 30 MB

4.
5.
6.
7.

Note the metaspace size.
Drag the left slider so that the metaspace size is between 36 MB and 46 MB.
Click Save.
Click Yes to restart the station.

Upgrading FX Server to FX Supervisory Software 14
About this task:
FX Server uses a similar upgrade process as supervisory controllers. However, there is no need to
use the FX14UpgradeAssessmentToolV1_9 with the FX Server to determine whether there are
enough resources to migrate.
Use the following process when you upgrade an FX Supervisory Software 14.
1.

2.

Back up the FX Server to create a .dist file. For details, see Backing Up Your FX Workbench
6.x Station. Also go to the Backup Service to ensure that the history and alarm entries are
removed (so the system does not bring the histories and alarms in the backup file).
Run the migration tool. For details, see Detailed Procedures for Migrating to FX Supervisory
Software 14.x. In the migration tool, be sure to:
- select the .dist file that you backed up.
- select Migrate FX Server Station.

Downgrading an FX80 from 14.x to 6.x
About this task:
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Note: We recommend that you run a serial shell running to monitor the progress of this
installation. Having the serial shell open helps you monitor the items being loaded on the FX
Supervisory Controller, track errors, and view when the migration is finished.
1.
2.
3.
4.
5.
6.
7.
8.
9.

In FX Workbench 14, connect to an FX Supervisory Controller platform.
Go to the Station Copier and delete the FX Supervisory Controller 14 station.
On the Nav tree, select Platform > Distribution File Installer. The Distribution File Installer
screen appears.
On the bottom of the screen, click Conversion. Conversion files that are not appropriate for
use on the current FX Supervisory Controller are disabled.
Select the bold (non-disabled) .dist file and click Install
If a station is running, a dialog box appears indicating that FX Workbench must stop the
station prior to installing the .dist file.
Click Finish. The Installing Distribution screen appears and the installation begins. This
process may take several minutes.
Once the distribution file is installed, click Close.
Close FX Workbench 14.

Running Platform Daemon 6.x
About this task:
When you open the Platform Daemon 6.x, you are indicating the version of FX Workbench you want
to run.
Note:
•

Certain antivirus programs may attempt to block you from running the Platform Daemon
software.

•

Before running the platform daemon, be sure to close out any instances of FX Workbench
software.

Click Start > FX Workbench 6.x > Install Platform Daemon.

Installing a Backup 6.x Station
1.
2.
3.
4.
5.
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Open the platform for the FX Supervisory Controller. Use the default platform ID and
password (jci/FacilityExplorer61 or explorer).
In the Nav tree, select Platform > Distribution File Installer. The Distribution File Installer
screen appears.
Click Backups and select the backup .dist file to install. The backup file must match the FX
Supervisory Controller platform for the backup to be enabled in the list of backup files.
Click Install.
Click Next. If the backup has different TCP/IP settings than when the backup was created, a
screen appears prompting you to keep the existing TCP/IP settings or change them to what
was used when the backup was previously run.
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Figure 20: Restore TCP/IP Settings

6.
7.

Edit the settings as needed and click Finish. FX Workbench begins installing the backup of the
6.x station.
Click Close.
Note: If you want to migrate back to FX Workbench 14.x, you need to obtain another
license for FX Workbench 14.x.
Note: If you want to migrate back to FX Workbench 14.x, the platform credentials from
your previous migration were retained. You need to use those credentials. If you have
forgotten the default platform password, you can use the Serial Shell method to reset to
the default password.

Cleaning Tabbed Graphics
About this task:
Graphics with tabs at the bottom can still work in FX Supervisory Software 14.x. However, the way
these tabbed graphics were designed, the layout of the graphics within the tabs do not render
properly in FX Supervisory Software 14.x.
We recommend you remove the tabs to make them look more in line with FX Supervisory Software
14.x.
1.
2.
3.

In FX Workbench, open the property sheet of the device you want to change the graphic for.
In the PX File field, note the .px file. This is the file that you need to edit.
In the controller's directory structure, navigate to Files > px and double-click the file noted in
Step 2. Notice the tabs at the bottom of the image.
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Figure 21: Tabbed Image

4.

In the view selector at the top right of the screen, select PxEditor.

Figure 22: PxEditor - All Tabs

5.

6.
7.

To remove tabs from graphics and change the graphic to use a scroll pane instead of a border
pane, in the Widget Tree pane, expand BorderPane (Root) > TabbedPane (Content). Right-click
and delete all the LabelPane entries.
In the view selection, select Text Editor.
Go to the opening tags for the TabbedPane section of the Text Editor. Remove the following
lines:
<TabbedPane = "content" tabPlacement= "bottom">
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<LabelPane>
<Label name = "label" text = "Graphic"/>
8.
9.

Go to the closing tags for the TabbedPane section of the Text Editor.
Remove the following lines:
</LabelPane>
</TabbedPane>

10. To reset the canvasPane to orient to the top left and remove scaling, go to the CanvasPane
Properties of the graphic.
11. Select the following values:
- In the halign field, select Left.
- In the scale field, select None.
- In the valign field, select Top.
12. Click OK.

Troubleshooting
Table 18: Migration Troubleshooting
Problem

The Migration Results section in
the Migration Report file indicates
that .dist file did not complete
successfully. The Failure List
includes the following error
IllegalNameException: There
can be only one Admin role.

Description
Although multiple roles with the name admin roles can
be configured and exist on an FX Workbench 6.x station,
the migration enforces only role with the name Admin
role for Migration. Delete any additional roles with the
name admin leaving only a single one remaining. Once
the additional Admin roles have been removed, run the
migration tool again.
Note: The additional roles with an Admin name may
be hidden. To view and remove hidden roles, use the
Slot Sheet view of the UserService. Also, having the
names admin and Admin is considered having two
admin roles.

The Client Password test ensures that passwords in the FX
Supervisory Software 6.x station can be decrypted for use
in FX Supervisory Software 14.x. A failure indicates that a
When running the Migration Tool, the
password could not be decrypted. If a failure occurs, reClient Password Test Fails.
enter the password for the failed user in the running FX
Supervisory Software 6.x station and re-run the Migration
Tool.
The FX14UpgradeAssessmentTool
does not indicate whether the free
disk space, free heap memory, or
RAM disk size have passed.

For FX Supervisory Controllers, the
FX14UpgradeAssessmentTool must be run on the
controller itself.
Note: Running the FX14UpgradeAssessmentTool on
a station running on a computer does not check for
free disk space, free heap memory, and RAM disk size.
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Table 18: Migration Troubleshooting
Problem

Description

When trying to access the web
user interface with Firefox™, there
is a pop-up dialog box that keeps
disappearing before I can interact
with it.

In the Add-ons section, set the Java Platform plug-in to
Always Activate. Close all instances of the browser,
restart the browser, and navigate to the web user
interface. The dialog box should now stay visible in order
for you to interact with it.

The host remembers credentials from a previous attempt
to migrate. For example, if you attempt to migrate a
station from FX Supervisory Software 6.x to FX Supervisory
Software 14.x and then decide to take it back to FX
When trying to migrate my station,
Supervisory Software 6.x, the FX Supervisory Software 14.x
you cannot log into the platform with platform credentials are still retained in the host. When
FX Supervisory Software 14.x
you attempt to migrate to FX Supervisory Software 14.x the
second time, the required credentials are the ones defined
during the first attempt. If you have forgotten or do not
have those credentials, the defaults can be reset using a
Serial Shell connection to the host.
A station migrated to FX Supervisory
Software 14.x still needs a JAVA plugin for the browser.

Migrating a station does not automatically change user
profiles to the new HTML5HxProfile. You must change the
Default Web Profile to HTML5HxProfile for each user that
requires this functionality. For more details, see Changing
the Default Web Profile to Use the HTML5HxProfile.

When adding a new user or
modifying a password, the fields are
disabled in the user interface.

Starting with FX Supervisory Software 14.x, you are no
longer allowed to add or modify sensitive information
when using a non-secure connection. Refer to the FX
Workbench User Guide (LIT-12011149) for more information.
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Table 18: Migration Troubleshooting
Problem

Description

This message appears because the security certificate
Browser displays Your connection
cannot be verified. Click the Advanced link, and then click
is not private.
the Proceed to ###.###.###.### (unsafe) link.
An Install software error
appears when installing the
distribution file. Install
Software: Failed

The following error appears when
logging into a station using a web
browser. HTTP ERROR 500
Problem accessing /ord/
station%7Cskit:fxApp Reason:
java.baja.xml.SException:
Unknow type ForecaseView
[line80]

There may not be enough room on the controller. Go to
the Station Copier and, if there is an the FX Supervisory
Controller 14 station on the controller, delete the station
from the controller.
The forecasting module used with FX Workbench Home
pages does not work with FX Supervisory Software Release
14. If you are trying to view a migrated station's Home
page using the HTML5HxProfile view, an error appears if
the Hx view in the forecasting information is not removed
from the view.
1.

On the Home page, select Edit Site Home from the
view selector (top-right corner of the screen).

2.

Click and drag to select all of the Weather Forecast
objects in the lower left are of the Hx graphic.

3.

Press Delete.

4.

Change the view back to the appropriate Home page.
When asking if you want to save your changes, click
Yes.

Problem
My graphic no longer appears in my migrated station.
Description
FX Supervisory Software 6.x may have been able to render some file types which have certain
characters in the filename that are not recognized (see the following sections for guidelines around
naming). Rename your file with appropriate characters and re-link your graphic as necessary.
Component Naming
In a FX Supervisory Software 6.x station, you should name components using the following set of
rules:
•

Only alphanumeric (A-Z, a-z, 0-9) and underscore (_) characters are used.

•

Symbols characters (for example, %, &, ., #) are not allowed.

•

The first character in the name must be a letter (not a numeral).

•

Name must be unique for every component within the same parent component.

•

Naming is case-sensitive. For example, zone21 and Zone21 are unique names.
Note: Case differences among names affect the sorting of names in table-based views. The
sorting order uses capital letters (A-Z) first and lower case (a-z) following.
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To convey multiple word names without using spaces, naming conventions such as
CamelCase and underscores are often used, as needed. For example:
•

Floor1 or Floor_1

•

ReturnAirTemp or Return_Air_Temp

•

Zone201_SAT or Zone_201_SAT

Escaped Names
You can name components in FX Workbench incorrectly, such as with spaces or other nonalphanumeric characters. Further, various FX Supervisory Software 6.x drivers have learn features
to automate the creation of points, some of which (by default) may also have such incorrect names
—reflective of the native name of the source object. For example, a BACnet proxy point might have
the default name Zone 6 RH% that matches the actual (native) BACnet object’s name.
Be aware that the actual component name has all illegal characters escaped using a $ character,
along with the ASCII code for that character, in hexadecimal code. For example, a proxy point
has the name Zone$206RH$25, where the $20 replaces the space and the $25 replaces the %. You
can see these escaped names in the slot sheet of the component’s parent container. Or with the
component selected, look at its ord (shortcut Ctrl + L) to see the actual name.
For the most part, this escaped name scheme is transparent to users. When the name appears
to the user (for example, in the Nav tree, property sheet, wire sheet, or a point manager), the
component’s name is unescaped by replacing the code (for example, $20) with the actual ASCII
character (for example, a space). This way, the user sees Zone 6 R % and so on. This is the
component’s display name.
In some cases, escaped names lead to confusion. Avoid them or rename them, if possible. For
example, if you add history extensions to escaped-named points, you see those escape codes listed
for source points when accessing the History Ext Manager (although associated histories use the
display names). If you build Px pages and manually type the ords in Px widgets, you probably know
source points by display names only. If you manually type in an ord without the actual (escaped)
name, the widget binding fails with an error.
When using the HTML5HxProfile, the home page graphics created with previous versions of Facility
Explorer use a forecasting module. This module has not been updated for use with HTML5 and still
requires a Java plug-in. You can remove the components on the home page so that the rest of the
Home Page can appear without errors.

Related Documentation
Table 19: Related Documentation
For information about

See document

LIT or Part Number

The Features, Benefits, and
Specifications of the FX Supervisory
Controller

FX Supervisory Controller Product
Bulletin

LIT-12011406

FX30E/FX60E Supervisory Controller
Installation Instructions

Part No. 24-10174-115

FX70 Supervisory Controller
Installation Instructions

Part No. 24-10564-17

FX80 Supervisory Controller
Installation Instructions

Part No. 24-10143-861

How to Install the FX Supervisory
Controller

46

FX Supervisory Controller Upgrade and Migration Instructions Technical Bulletin

Table 19: Related Documentation
For information about
The Features, Benefits, and
Specifications of the FX Server

See document

LIT or Part Number

FX Server Product Bulletin (6.x and
Earlier)

LIT-12011122

FX Server Product Bulletin (14.x and
Later)

LIT-12012251

The Operation of FX Workbench

FX Workbench User's Guide

LIT-12011149

How to Install FX Workbench

FX Supervisory Controller Family
Software Products Installation
Instructions

LIT-12011965

Appendix
Migration Checklist
Action

Resources

Check the platform compatibility
Refer to the FX Supervisory Controller Upgrade and
list to determine whether or not the
Migration Instructions (LIT-12011441).
desired platform can be migrated.
Check driver, feature, and
application compatibility.

Refer to the FX Supervisory Controller Upgrade and
Migration Instructions (LIT-12011441).
Refer to the FX Workbench Pro Help.
Check directly with third-party vendors.
Refer to the FX Supervisory Controller Product
Bulletin (LIT-12011406).

Purchase the appropriate FX
Supervisory Software 14 Software
Maintenance for FX Servers and FX
Supervisory Controllers (to move
from 6.x to 14.x).

Migrate FX Server and FX
Supervisory Controller stations
and change users default profile to
HTML5HxProfile as desired.

For North America, contact Johnson Controls
Product Software Sales at 1-414-525-7906 or
1-800-275-5676, email jciorder@jci.com, or
fax to 1-800-356-1191. For answers to pricing
questions, contact your channel account
manager. For sales queries outside North
America, contact Johnson Controls at http://
www.johnsoncontrols.com/contact-us.
Refer to the FX Supervisory Controller Upgrade and
Migration Instructions (LIT-12011441).

FX Workbench 14.x Modules
Use this table as a reference when selecting modules during FX Workbench commissioning. This
modules listed below are the suggested modules needed for the JCI appliance on an FX80. All
modules sizes are approximate.
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Table 20: FX Workbench 14.x Modules
Module Name

Size

alarm-rt.jar

Module Name

Size

339.5
KB

kitPx-ux.jar

11.7 KB

alarm-ux.jar

178.6
KB

kitPx-wb.jar

121.8
KB

alarm-wb.jar

488.6
KB

kitPxHvac-wb.jar

634.8
KB

app-rt.jar

21.1 KB

kitPxHvacSmall.jar

443.3
KB

app-wb.jar

13.2 KB

mobileThemeZebraux.jar

24 KB

axvelocity-rt.jar

1383.5
KB

mobile-ux.jar

519.9
KB

axvelocity-wb.jar

28.9 KB

mobile-wb.jar

195.5
KB

backup-rt.jar

62.3 KB

modbusAsync-rt.jar

24.2 KB

backup-wb.jar

23 KB

modbusAsync-wb.jar

9.8 KB

bacnet-rt.jar

1825.7
KB

modbusCore-rt.jar

220.2
KB

bacnet-ux.jar

190.2
KB

modbusCore-wb.jar

46.7 KB

bacnet-wb.jar

311.5
KB

modbusTcp-rt.jar

31.2 KB

baja.jar

2200.6
KB

modbusTcp-wb.jar

11.3 KB

bajaScript-ux.jar

434.1
KB

neql-rt.jar

82.5 KB

bajaui-wb.jar

1280.7
KB

net-rt.jar

63.6 KB

bajaux-rt.jar

28.5 KB

niagaraDriver-rt.jar

360 KB

bajaux-ux.jar

89.5 KB

niagaraDriver-wb.jar

183.6
KB

basicDriver-rt.jar

59.3 KB

niagaraVirtual-rt.jar

133.5
KB

box-rt.jar

203.8
KB

niagaraVirtual-wb.jar

17.9 KB

bql-rt.jar

269.3
KB

nsh-wb.jar

20.8 KB

bql-ux.jar

63 KB

obix-rt.jar

218.1
KB

chart-rt.jar

14.9 KB

obixDriver-rt.jar

324.4
KB
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Table 20: FX Workbench 14.x Modules
Module Name

Size

chart-wb.jar

Notes

Module Name

Size

200.3
KB

obixDriver-wb.jar

63 KB

control-rt.jar

79.7 KB

pdf-wb.jar

112.9
KB

control-ux.jar

31.3 KB

platBacnet-rt.jar

25.9 KB

control-wb.jar

22.5 KB

platCrypto-rt.jar

119.4
KB

converters-rt.jar

129 KB

platCrypto-wb.jar

206.6
KB

driver-rt.jar

169.2
KB

platDataRecovery-rt.jar

122.3
KB

driver-ux.jar

47.7 KB

platDataRecovery-wb.jar 37 KB

driver-wb.jar

106.8
KB

platMstp-rt.jar

33.2 KB

email-rt.jar

89.8 KB

platPower-rt.jar

45.8 KB

email-ux.jar

33 KB

platPower-wb.jar

28.3 KB

email-wb.jar

24.4 KB

platSerial-rt.jar

23.3 KB

entityIo-rt.jar

21 KB

platSerialQnx-rt.jar

22.4 KB

file-rt.jar

97.6 KB

platform-rt.jar

905.2
KB

fonts-rt.jar

234.4
KB

platform-wb.jar

491.3
KB

fox-rt.jar

398.2
KB

program-rt.jar

89.5 KB

gx-rt.jar

129.6
KB

program-wb.jar

230.5
KB

gx-ux.jar

14.3 KB

pxEditor-wb.jar

625 KB

gx-wb.jar

770.3
KB

query-rt.jar

51 KB

haystack-rt.jar

84.6 KB

queryTable-wb.jar

141.9
KB

hierarchy-rt.jar

124.1
KB

report-rt.jar

66 KB

hierarchy-ux.jar

27.7 KB

report-ux.jar

25.5 KB

hierarchy-wb.jar

16.8 KB

report-wb.jar

103.3
KB

history-rt.jar

473 KB

schedule-rt.jar

123.6
KB

history-ux.jar

56.9 KB

schedule-ux.jar

155 KB

history-wb.jar

321.3
KB

schedule-wb.jar

252.1
KB
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Table 20: FX Workbench 14.x Modules
Module Name

Size

html-wb.jar

Module Name

Size

33.7 KB

search-rt.jar

47.2 KB

hx-wb.jar

472.9
KB

search-ux.jar

60 KB

icons-ux.jar

692.8
KB

search-wb.jar

15.7 KB

jciAutoTagging.jar

80.2 KB

serial-rt.jar

23.3 KB

jciN2ColorTec.jar

48KB

jciBacnetColorTec.jar

72KB

jciBacnetParser.jar

78.4 KB

serial-wb.jar

9.9 KB

jciCoreParser.jar

131.5
KB

silk-rt.jar

32.1 KB

jciDictionary.jar

407.5
KB

smartTableHx-wb.jar

283.7
KB

jciFxDriver.jar

388.7
KB

tagdictionary-rt.jar

163.2
KB

jciFxDriverApplianc
549 KB
e.jar

tagdictionary-wb.jar

44.7 KB

jciFxDriverHx.jar

291 KB

template-rt.jar

112.2
KB

jciMeters.jar

31.7 KB

template-wb.jar

4354.7
KB

jcin2.jar

762.4
KB

themeLucid-ux.jar

949.4
KB

jciN2Parser.jar

164.4
KB

themeZebra-ux.jar

805.7
KB

jciSpaces.jar

186.7
KB

tunnel-rt.jar

63.4 KB

jciSupport.jar

171.3
KB

wbutil-wb.jar

538.6
KB

weather-rt.jar

180.5
KB

jciTagDictionary.jar 9.4 KB

Notes

New for FX
14.6

New for FX
14.6

jciTools.jar

30.5 KB

weather-wb.jar

315.7
KB

jciViews.jar

107.8
KB

web-rt.jar

622.1
KB

jetty-rt.jar

76.4 KB

webChart-rt.jar

31.6 KB

js-ux.jar

1728.8
KB

webChart-ux.jar

232.6
KB

jxBrowser-wb.jar

50 KB

webEditors-ux.jar

884.9
KB
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Table 20: FX Workbench 14.x Modules
Module Name

Size

kitControl-rt.jar

Notes

Module Name

Size

Notes

296.9
KB

wiresheet-wb.jar

203.4
KB

kitControl-ux.jar

101 KB

workbench-wb.jar

2510.3
KB

kitControl-wb.jar

11.9 kb

jciMgr.jar

55KB

Historical software revision numbering
Table 21: Niagara Version Used

X

NA

NA

NA

NA

1.1

Minor release that introduced
the update to the N2 Device
Manager, corrections to the
Variable Air Volume (VAV)
3.0.99
Modular Assembly (VMA)
occupancy enumerations, and
other minor bug fixes.

NA

NA

X

NA

NA

NA

NA

1.2

Minor release that introduced
several enhancements and
bug fixes, including a new
tabbed structured system
3.0.106
graphic template, new
Schedule, Point Group, and
Link Managers, and FX Alarm
Portal.

NA

NA

X

NA

NA

NA

NA

2.0

Major release that introduced
the FX20 and FX60 Supervisory
Controllers and accessories,
FX Server Limited, FX Server
3.3.22
driver options, FX Alarm Portal
client, and bug fixes to the N2
driver.

X

NA

X

X

NA

NA

NA
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FX80

NA

FX70

NA

FX60E

3.0.88

FX60

1.0

Initial release that introduced
the FX40 Supervisory
Controller, FX Server, and FX
Tools Supervisor Pro.

FX40

Niagara
Software
Versions

FX30E

Key Identifying Features or
Changes

FX20

SR
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Table 21: Niagara Version Used
Niagara
Software
Versions

NA

NA

NA

2.2

Minor release that introduced
support for iPhone® interface
or a similar sized graphical
3.3.31
user interface and the Point
Order field to the System
Library.

X

NA

NA

X

NA

NA

NA

3.0

Major release that introduced
the FX22, FX62, and FX70
Supervisory Controllers and
accessories, FXRIO Remote
3.5.25
Input/Output (I/O) Module,
and General Packet Radio
Service (GPRS) Modem option
card.

X

NA

NA

X

NA

X

NA

3.1

Minor release that introduced
the Assisted Device Import
feature, which supports the
3.5.34
new FX-PC Programmable
Controllers.

X

NA

NA

X

NA

X

NA

4.0

Major release that introduced
the FX20, FX60, and FX70
Supervisory Controllers with
factory-installed BACnet® MS/
TP protocol driver licenses,
3.6.31
additional option cards, FX
Energy Suite, and FX20/FX60
basic demo supervisory
controllers.

X

NA

NA

X

X

X

NA

4.1

Minor release that introduced
FX Server changes, BTL
Certification, and changes to
3.6.47
the method of FX Supervisor
Controller family software
delivery and licensing.

X

NA

NA

X

X

X

NA

4.1

Patch release

X

NA

NA

X

X

X
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3.6.407

FX80

X

FX70

X

FX60E

NA

FX60

X

FX40

2.1

Minor release that introduced
the Wireless TEC Option card,
LX Series LON Controller
3.3.31
configuration wizards, a New
Station wizard, and the Global
Point Extension Manager.

FX30E

Key Identifying Features or
Changes

FX20

SR
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Table 21: Niagara Version Used

NA

X

X

X

NA

5.1

Minor release that introduced
updates to FX Workbench.
These updates include Batch
Import, Simple Plant Standard
Graphics, Point Summary
3.7.106
Manager, Hardware Scan
Service, Graphic Sizing
Selection for Mobile Devices,
and Launch FX-PCT.

X

X

NA

X

X

X

NA

5.2

Minor release that introduced
the FX30E and FX60E
Supervisory Controllers. Also
introduced were updates
3.7.106
to tuning polices in FX
Workbench, N2 Help, and
Zoning application graphics.

X

X

NA

X

X

X

NA

5.3

Patch release

3.7.108

X

X

NA

X

X

X

NA

6.0

Major release that allows FX
Workbench to run on the
Niagara 3.8 platform.

3.8.38

NA

X

NA

X

X

X

NA

6.1

Minor release that introduced
updates to FX Workbench.
These updates include Spaces
3.8.38
and Equipment, Meters,
WT4000, and updates to the
Point Summary Manager.

NA

X

NA

X

X

X

NA

6.2

Patch release

NA

X

NA

X

X

X

NA

6.3

Minor release that introduced
updates to FX Workbench.
These updates include
support for the FX80,
3.8.111
Java® Web Start, support
for Windows® 10, and an
improved system usability.

NA

NR

NA

X

X

X

X

6.4

Patch release

3.8.213

NA

NR

NA

X

X

X

X

6.5

Patch release

3.8.311

NA

NR

NA

X

X

X

X

3.8.41
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FX80

X

FX70

X

FX60E

3.7.106

FX60

5.0

Major release that introduced
revised graphic images and
templates, N2 device convert
manager, and new wizard
service for LX controllers.

FX40

Niagara
Software
Versions

FX30E

Key Identifying Features or
Changes

FX20

SR

53

Table 21: Niagara Version Used

NA

X

X

X

X

4.0.22.16

NA

NR

NA

X

X

X

NA

FX80

NR

FX70

NA

FX60E

3.8.401

FX60

6.6

Minor release that provides
four functional fixes: a new
system property that allows
extending the timeout on
platform connection, a fix for
CCN Numeric override never
stops writing, certificates
can now be approved for TLS
connections from WebStart
and the weather service can
now follow URI redirects

FX40

Niagara
Software
Versions

FX30E

Key Identifying Features or
Changes

FX20

SR

Major release that allows FX
Workbench to run on the
Niagara 4 platform.
14.0

The jump from 6.x to 14.x
was intentional to align with
the Niagara software version
moving forward.

14.1

Minor release that adds
support for FX80 Supervisory
Controllers

4.1.27.20

NA

NR

NA

X

X

X

X

14.2

Minor release that adds
Analytics 2.0 to FX Workbench.
There is also support for the
Alarm Portal, more robust
4.2.36.38
FX Server data management
features, and support for FX80
legacy drivers.

NA

NR

NA

X

X

X

X
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Table 21: Niagara Version Used
Niagara
Software
Versions

X

X

X

14.4

Minor release adding
new HTML5 screens to FX
Workbench, improving mobile
web device functionality.
Minor change to the User
Service making the scheduled
4.4.73.6
access for users available
through the User Details
section. The JCI User manager
has been removed. Updating
an existing Nav file is through
the Toolsmenu.

NA

NR

NA

X

X

X

X

NA

NR

NA

X

X

X

X

Minor release that provides
eighteen functional fixes.
These included updated
firmware to solve FX80
WIFI modem failure, a fix
to Niagara Daemon Engine
Watchdog, and fixes to
14.4U1 lexicons, hyperlinking,
scrolling, and adding notes.

4.4.92.2

FX80

X

FX70

NA

FX60E

NR

FX60

NA

FX40

14.3

Minor release that introduced
two new RIO modules. The
release also adds new HTML5
4.3.58.18
screens to FX Workbench and
improved mobile web device
functionality.

FX30E

Key Identifying Features or
Changes

FX20

SR

There was also
internationalization fixes to
lexicons and locales along
with web fixes to PDF Export,
Webchart, popups, PxIncludes
and HTML5 property sheets.
Note: NR stands for Not Recommended and SR stands for Software Release.
Note: Based on poor performance observed under lab conditions, we do not recommend that
you use the FX30E with software release 6.3 or any subsequent software release.
Note: 14.4 is the final 14.x release that supports the FX30E, FX60E, and FX70. After 14.4, the 14.x
releases will only support the FX80. See Software Revision Numbering for the latest software
revision numbers.
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Product warranty
This product is covered by a limited warranty, details of which can be found at
www.johnsoncontrols.com/buildingswarranty.

Software terms
Use of the software that is in (or constitutes) this product, or access to the cloud, or hosted
services applicable to this product, if any, is subject to applicable end-user license, opensource software information, and other terms set forth at www.johnsoncontrols.com/
techterms. Your use of this product constitutes an agreement to such terms.

Single point of contact
APAC

Europe

NA/SA

JOHNSON CONTROLS

JOHNSON CONTROLS

JOHNSON CONTROLS

C/O CONTROLS PRODUCT MANAGEMENT

WESTENDHOF 3

507 E MICHIGAN ST

NO. 32 CHANGJIJANG RD NEW DISTRICT

45143 ESSEN

MILWAUKEE WI 53202

WUXI JIANGSU PROVINCE 214028

GERMANY

USA

CHINA

Contact information
Contact your local branch office: www.johnsoncontrols.com/locations
Contact Johnson Controls: www.johnsoncontrols.com/contact-us

© 2021 Johnson Controls. All rights reserved. All specifications and other information shown were current as of document
revision and are subject to change without notice.

